Getting started
with
Solid Edge with Synchronous Technology
Getting started with Solid Edge with Synchronous Technology

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2008 Siemens Product Lifecycle Management Software Inc. All Rights Reserved. All trademarks belong to their respective holders.
Welcome to Solid Edge!

This guide demonstrates typical workflows for modeling synchronous parts and assemblies with Solid Edge with Synchronous Technology.

This tutorial introduces basic concepts that other tutorials rely upon, so it is a good place to start if you are a beginner.
Lesson

1 **Basic part modeling**

Solid Edge is made up of several components called environments. These environments are tailored for creating individual parts, sheet metal parts, assemblies, and detail drawings.

The Solid Edge: Part environment allows you to construct a base feature and then modify that base feature with additional features such as protrusions, cutouts, and holes to construct a finished solid model.

You model parts in Solid Edge with Synchronous Technology using the following basic workflow:

- Draw a sketch for the first feature.
- Add dimensions to the sketch.
- Extrude or revolve the sketch into a solid feature.
- Add more features.
- Edit the model dimensions and solid geometry to complete the part.
Create a Solid Edge file

Step 1: Start Solid Edge

☐ Click the Windows Start button, then choose All Programs → Solid Edge ST → Solid Edge.

Solid Edge displays the startup screen.

Step 2: Create a Synchronous ISO Part file

☐ In the Create area of the startup screen, click Synchronous ISO Part.

Step 3: Save the part

☐ On the Quick Access toolbar, located at the top-left side of the application window, click the Save button to save the file.

A properties dialog box is displayed. With this dialog box you could specify project and status information associated with the part. But since this is just an exercise, there is no point in doing that now.

☐ On the properties dialog box, click OK.

A Save As dialog box is displayed, where you can specify the name and location for the new file.

☐ Specify a name and location that are convenient for you and click OK.
Create the base feature

Step 1: Observe the base coordinate system

The first step in drawing any new part is drawing the sketch for the base feature. The first sketch defines the basic part shape.

You will first draw a sketch on one of the principal planes on the base coordinate system, and then extrude the sketch into a solid.

What is the base coordinate system for?

The base coordinate system is located at the origin of the model file, as shown above. It defines the principal x, y, and z planes, and can be used in drawing any sketch-based feature.

Note

Depending on the configuration of your computer, there may also be a view orientation triad displayed in the graphics window. If so, the base coordinate system is the element shown highlighted in the illustration below. The view orientation triad, which cannot be selected, is for view orientation purposes only. For the remainder of this tutorial, the view orientation triad will not be shown.
Lesson 1  Basic part modeling

Step 2:  Start the Rectangle command

In the next few steps, you will draw the rectangle shown in the illustration.

Choose Home tab→Draw group→Rectangle
Step 3: Specify the sketch plane using QuickPick

- Position the cursor over the base coordinate system as shown in the illustration above, stop moving the mouse for a moment, and notice that the cursor image changes to indicate that multiple selections are available.

- Right-click, and the QuickPick tool is displayed, as shown below. Move the cursor over the different entries in QuickPick, and notice that different principal planes on the coordinate system highlight in the graphics window. QuickPick allows you to select what you want when multiple selections are available.

- Position the cursor over the entry in QuickPick that highlights the XY principal plane as shown below, then click to select it.
Step 4: Observe the alignment lines attached to the cursor

Move the cursor around the graphics window and notice that alignment lines extend outward from the cursor.

The alignment lines are oriented to the principal plane you selected in the previous step.
Step 5: **Draw a rectangle**

- Position the cursor at the approximate location shown, and click to define the start point of the rectangle.

- Move your cursor to the right, and notice that the Width and Angle boxes on the Rectangle command bar on the left side of the screen update to reflect the current cursor position.

| Width: 51.17 mm | Height: 0.00 mm | Angle: 0.00 ° |

- Position the cursor so that the Width value is approximately 50-70 mm and the Angle is exactly 0.00 degrees, then click to define Point (2) of the rectangle, as shown below.

- Position the cursor approximately as shown below, and when the Height value for the rectangle is approximately 40-50 mm, click to define Point (3) of the rectangle.
Lesson 1  

Basic part modeling

Step 6: Observe the rectangle

Take a few moments to observe the rectangle displays as a shaded element.
The rectangle displays as a shaded element because the lines that form the rectangle define a closed area.
In Solid Edge: Synchronous Technology, when 2D elements form a closed area, they are called sketch regions. You use sketch regions to create solid features.
Edit the sketch

Step 1: Start the Select command

To illustrate how you delete and add elements to a sketch, in the next few steps you will use the Select tool to delete one of the lines of the rectangle, and then draw a replacement line.

The Select tool lets you select elements so they can be edited, copied, and deleted.

Choose Home tab→Select group→Select.
Lesson 1  

Basic part modeling

Step 2:  Delete a line

☐ Move the cursor over the four lines in the sketch. Notice that the lines highlight as the cursor passes over them.

☐ Position the cursor over the line shown in the illustration, then click the left mouse button to select the line. Notice that the color of the line changes to indicate it has been selected.

☐ Press the Delete key on the keyboard to delete the line.

   Note

The cursor must be positioned in the Solid Edge window when you press the Delete key.

Notice that the shaded sketch region is no longer displayed. This is because the series of lines that formed the rectangle no longer form a closed area.
Step 3: Draw a new line

☐ Choose Home tab→Draw group→Line.

☐ Move the cursor to the endpoint of the line shown in the top illustration, and when the endpoint relationship indicator displays adjacent to the cursor, click.

☐ Move the cursor to the endpoint of the line shown in the bottom illustration, and when the endpoint relationship indicator displays adjacent to the cursor, click.

☐ When you have finished drawing the line, right-click to restart the Line command.
Step 4: Observe the results

Take a few moments to observe the results of the line you drew. Because the sketch elements now form a closed and connected sketch region, the rectangle formed by the lines now displays shaded to indicate it is a sketch region.
Construct the base feature

Step 1: Prepare to construct the base feature

In the next few steps, you will construct the base feature using the sketch you just drew.

In Solid Edge with Synchronous Technology, you can construct solid geometry using two basic approaches:

- You can use a robust set of traditional modeling commands such as extrude, revolved protrusion, and hole to construct specific types of features.

- You can use the Select tool to construct the most frequently used types of features: extruded and revolved protrusions and cutouts.

Both approaches produce the same results, and you will use both methods in this tutorial. As you gain experience, feel free to use the approach that is more comfortable for you.

To construct the base feature, you will use the Select tool. Using the Select tool reduces the number steps required to construct these frequently used features.
Step 2: Start the Select command and select the sketch region

Choose Home tab→Select group→Select.

Position the cursor over the sketch region as shown, then click to select it.

In the next few steps, you will learn about the on-screen tools that were displayed when you selected the sketch.

Note

Depending on the current settings on your computer, the sketch region may highlight as a shaded element or only the edges may highlight.
Step 3: Observe the on-screen tools

Notice the following, as shown in the illustration:

- A floating menu, called QuickBar (A) is displayed in the graphics window.
- An Extrude handle (B) is displayed on the sketch, near where you selected the sketch.

QuickBar displays a list of possible actions and the available options for the current action.

The Extrude handle is used to construct the feature. Before you construct the feature, you will learn more about QuickBar.
Step 4: QuickBar overview

QuickBar is displayed when you select certain types of elements. QuickBar evaluates the selected elements and presents a targeted set of Actions and Options.

Actions:

The Actions list is displayed on the left side of QuickBar (A).

For a sketch region, the default action is to construct an extruded feature. You can select a different action from the Actions list. For a sketch region, you can specify that you want to construct a revolved feature instead.

Options:

The options available for the current action are displayed on the remainder of QuickBar. For an extruded feature you can specify whether material is added or removed, the feature extent, whether the feature is constructed symmetrically about the sketch region, and so forth.

You will explore some of these options as you work through the tutorial.
Step 5: Ensure the proper options are set on QuickBar

- On QuickBar, ensure the following options on your computer match the illustration:
  
  (A) The Extent Type option is set to Finite.
  
  (B) The Symmetric Extent option is cleared (not set).
  
  (C) The Treatments option is cleared.
Step 6: Select the Extrude handle and define the base feature extent

- Position the cursor over the extrude handle as shown above, and when it highlights, click the left mouse button.
- Move the cursor above and below the sketch and notice that the feature is drawn dynamically as you move the cursor.

Also notice that a dynamic input box is displayed in the graphics window.

- Position the cursor below the sketch, type 20 in the dynamic input box, then press the Enter key to define the extent for the feature, as shown below.

You have completed the base feature.
Step 7: Observe the results

Your graphics window should resemble the illustration. Notice that a solid base feature is displayed and that the sketch is no longer displayed.

When you construct sketch-based features in Solid Edge with Synchronous Technology, the sketches are discarded after you construct a feature.
Explore PathFinder

Step 1:

Take a few moments to explore PathFinder, located on the bottom-left side of the application window.

You use PathFinder to help you evaluate, select, and edit the components that comprise the models you create in Solid Edge.

Click the + symbols in PathFinder to expand the various headings until your display matches the illustration.

Notice the following in PathFinder:

- A Features heading that contains a Protrusion 1 entry, which represents the base feature you constructed.

- A Used Sketches heading that contains a Sketch 1 entry for the sketch you used to construct the feature.

When you construct sketch-based features, the sketches are added to the Used Sketches collection in PathFinder in case you want to use them for subsequent features later.
Step 2: Hide the base coordinate system using PathFinder

In PathFinder, in the Coordinate Systems collector, position the cursor over the checkmark adjacent to the Base entry, then click to hide the Base coordinate system.

Notice that the Base entry in PathFinder changes color and that the Base coordinate system is hidden in the graphics window.

Step 3: Save the part

On the Quick Access toolbar, located at the top-left side of the application window, click the Save button to save the work you have done so far.
Construct another extruded feature

In the next few steps, you will construct another extruded feature, as shown in the illustration.

You will use a workflow similar to the one you used to construct the base feature.

Step 1: Evaluate the sketch

In the next few steps, you will draw the sketch for the next feature, as shown in the illustration.

- You will display the geometric relationships that help define the behavior of the 2D elements of the sketch.
- You will lock cursor input to the front planar face on the model.
- You will use the Line command to draw the two lines and arc shown.
Step 2: Display the relationship handles

Choose View tab→Show group→Relationship Handles.

This specifies that you want to display the relationship handles that help control the behavior of 2D sketches. You will learn more about this after you draw the sketch.

Step 3: Start the Line command

You can also use the Line command to draw a series of connected lines and arcs.

Choose Home tab→Draw group→Line.
**Step 4: Lock sketch input to a model face**

When drawing sketches, you can lock sketch input to a specific planar face on the model. This can be useful when you want to draw outside the area defined by the planar face.

You can lock cursor input to the sketch plane using the lock symbol displayed adjacent to the cursor, or you can use a shortcut key.

- Position the cursor over the planar face shown in the illustration.

Notice the following:
- The planar face highlights.
- A lock symbol is displayed adjacent to the cursor.
- A Tooltip is displayed.

- Press the F3 key on the keyboard to lock sketch input to the selected face.

Notice that a locked plane indicator is displayed in the top-right corner of the graphics window, as shown below.

Also notice that when you move the cursor over the other model faces, they no longer highlight. All sketch input is now locked to the selected model face.
Step 5: Start the first line

- Position the cursor as shown in the illustration above, and when the end point relationship indicator displays adjacent to the cursor, click to start the line.

- Move the cursor upward. Notice the following:
  - A line stretches to follow the cursor wherever you move it.
  - When the line is nearly vertical, a vertical relationship indicator is displayed next to the cursor.
Step 6: Finish the first line

☐ Move the cursor until:

- The vertical relationship indicator is displayed at the cursor.
- The Length displayed on the command bar is approximately 45-50 mm.
- The Angle on the command bar is exactly 90 degrees.

☐ When the line is exactly vertical, and approximately 45-50 mm long, click to finish the first line.
Step 7: Draw an arc tangent to the line

The Line command is still active, ready to draw another line connected to the endpoint of the previous line. In this case, you want to draw an arc instead.

- On the Line command bar, click the Arc option, or press the A key on the keyboard. This specifies that you would like to draw an arc.

Four intent zones (A) are displayed at the endpoint of the line you just drew. The arc will be drawn perpendicularly or tangentially to the line, depending on which of the four intent zones you move the cursor through.

- Move the cursor through the different intent zones and notice how the arc behaves.

- On the Line command bar, in the Radius box, type 15 as the radius of the arc, and press the Enter key.

- Move the cursor up, through the top quadrant of the intent zone, and then to the right, so that the arc curves tangentially to the right.

- When a dotted horizontal line is displayed between the start and endpoints of the arc, as shown in the illustration, click.
Lesson 1  Basic part modeling

Step 8:  Draw the second line

The Line command is still active, ready to draw a line connected to the endpoint of the previous arc.

- Position the cursor as shown in the illustration above, and when the point on element and tangent relationship indicators display adjacent to the cursor $\mathcal{L}/\mathcal{E}$, click to finish the line.

- When you have finished drawing the line, right-click to restart the Line command.
Step 9: Observe the results

Take a few moments to observe the finished sketch.

Notice that the sketch elements display as a sketch region. This indicates that the sketch is valid for a constructing a feature using the Select tool. Although this sketch is not closed, it is treated as a region because the linear model edge at the bottom of the sketch closes the gap between the two lines on the sketch.

Also notice the relationship symbols where the lines connect to the solid model, to the endpoints of the arc, and at the midpoint of lines.

These relationships specify the following:

- The lines will remain connected to the model.
- The lines will remain connected and tangent to the arc.
- The lines will remain vertical.

Although the sketch and the relationships are discarded when you construct the next solid feature, building these relationships into the sketch is helpful. When you construct the solid feature, these 2D relationships orient the faces that are constructed from the sketch, and help define the behavior you want when editing the solid feature later.
Lesson 1  Basic part modeling

Step 10:  Unlock the sketch plane

Since you are finished drawing sketch elements, you will now unlock
the sketch plane.

□  With your cursor in the Solid Edge window, press the F3 key on the
keyboard to unlock the sketch plane.

Step 11:  Start the Select command and select the sketch region

□  Choose Home tab→Select group→Select.

□  Position the cursor over the sketch region, and when it highlights,
click to select it.

Again, the Extrude handle and QuickBar are displayed.
Step 12: Select the Extrude handle and define the feature extent

- Position the cursor over the Extrude handle, as shown above, and when it highlights, click to select it.

- Position the cursor behind the sketch and notice that the feature is drawn dynamically as you move the cursor.

- In the dynamic input box, type 20, then press the Enter key to define the extent for the feature, as shown below.
Step 13: Save the part

☐ On the Quick Access toolbar, click the Save button to save the work you have done sofar.
Construct another extruded feature

Step 1: Start the Circle by Center Point command

In the next few steps, you will sketch a circle. You will then use the circle to construct a boss on the part, as shown.

Choose Home tab→Draw group→Circle by Center Point.
**Step 2: Lock sketch input to a model face**

- Position the cursor over the planar face shown in the illustration. When it highlights, press the F3 key on the keyboard to lock sketch input to the selected face.

As before, notice that the locked plane indicator is displayed.

**Step 3: Define the center of the circle**

- Position the cursor over the arc-shaped edge of the model, as shown above, but do not click.

- Move the cursor to the approximate center of the arc-shaped edge, and notice that a center point indicator is displayed adjacent to the cursor, as shown below.

- While the center point indicator is displayed, click to place the center of the circle.
Step 4: Define the diameter of the circle

Position the cursor over the arc-shaped edge of the model, and when the point-on and tangent-to indicators are displayed, click to define the diameter of the circle.

Step 5: Unlock the sketch plane

Your display should match the illustration.

With your cursor in the Solid Edge window, press the F3 key on the keyboard to unlock the sketch plane.
Lesson 1  Basic part modeling

Step 6:  Start the Select command

You will use the Select tool to construct another extrude feature, as shown.

☐ Choose Home tab→Select group→Select.
Step 7: Select the sketch region

Position the cursor over the circle as shown, and when the sketch region highlights, click to select it.

QuickBar and the Extrude handle are displayed.
Lesson 1  

Basic part modeling

Step 8: Select the Extrude handle

☐ Position the cursor over the Extrude handle, and click to select it.

Step 9: Set the feature extent and direction

☐ Move the cursor in front of the model, as shown above.
☐ In the dynamic input box, type 10, then press the Enter key.

The feature is constructed, as shown below.
Step 10: Observe the results

Your extrude feature should resemble the illustration.

Step 11: Save the part

On the Quick Access toolbar, click the Save button to save the work you have done so far.
Construct a hole feature

Step 1: Prepare to construct a hole

In the next few steps you will construct a hole feature, as shown.

- Choose Home tab→Solids group→Hole.

Step 2: Define the hole parameters

- On the Hole QuickBar, click the Hole Options button. The Hole Options dialog box is displayed.

- Set the following hole properties:
  - Set the Type to Simple.
  - Set the Diameter to 15.
Step 3:  Set the centerpoint option on QuickBar

For this hole, you want the hole exactly centered on the circular face of the boss. You will set the centerpoint option on QuickBar to do this.

☐ On QuickBar, in the Keypoints list, set the Centerpoint option.

Step 4:  Position the hole feature

Notice that a hole feature is attached to the cursor.

☐ Move the cursor over different faces of the model, and notice that a preview image of the results are displayed.

☐ Position the cursor over the face shown in the illustration, but do not click.

☐ Move the cursor to the circular edge as shown, and notice that the hole centers itself on the circular face.

☐ Click to place the hole feature.

☐ Notice that a hole feature is still attached to the cursor. Since this is the only hole you want to construct, right-click to finish placing holes.
Step 5: Observe the results

Notice that in addition to the hole feature, that the steering wheel (A) and the edit definition handle (B) are displayed.

You will learn more about the steering wheel later.

The edit definition handle is used to edit procedural features, such as holes. For this activity, you will not edit the hole feature.

Step 6: Save the part

On the Quick Access toolbar, click the Save button to save the work you have done so far.
Round the edges

In the next few steps, you will use the Round command to round two edges on the part, as shown in the illustration.

Step 1: Start the Round command

Choose Home tab→Solids group→Round.
Lesson 1  
Basic part modeling

Step 2: Select the first edge to round

- Select the edge shown in the top illustration.
- When the dynamic edit box displays, type 15, and press the Tab key, as shown below.

Note

When rounding multiple edges, you should press the Tab key so you can continue to select more edges.
Step 3: Select another edge to round and finish the feature

Select the edge shown in the illustration.

Right-click to finish rounding edges.

Step 4: Observe the results

Your model should now resemble the illustration.
Place dimensions on the model

In the next few steps, you will place two dimensions on the edges of the model, as shown. These types of dimensions are called PMI, or 3D dimensions.

You can use these dimensions for reference purposes, or you can use them to drive changes to the model.

**Step 1: Start the Dimension command**

Choose Home tab→Dimension group→SmartDimension button.

You can use this command to place a dimension on one element or between two elements.
Step 2: Place the first dimension

Position the cursor over the edge as shown above, and when it highlights, click to select it. Notice that dimension elements are attached to the cursor.

Position the cursor below the model, and click to place the dimension, as shown below.

The dimension value on your model may be different than the illustration.
Step 3:  Select the first element to dimension

The SmartDimension command should still be active. This time, you will place a dimension between the bottom edge of the model, and the center of the hole you constructed earlier.

- Position the cursor over the bottom edge of the model, and when the edge highlights, click to select it.

Although dimension elements are attached to the cursor, this time you want to place a dimension that measures the distance between two elements.

Do not click to place the dimension. You will select the second element in the next step.

Step 4:  Select the second element to dimension

- Position the cursor over the circular edge of the hole, as shown in the illustration. When it highlights, click to select it.
Step 5: Position the dimension

Position the cursor to the left of the model, and click to place the dimension.

The dimension value for your dimension may be different than the illustration.

Step 6: Save the part

On the Quick Access toolbar, click the Save button to save the work you have done so far.
Modify the model using the steering wheel

In the next few steps, you will explore methods you can use to modify models in Solid Edge with Synchronous Technology. As with traditional modeling, you can use dimensions to modify your model.

First you will explore using the Select tool and the steering wheel to interact directly with the faces on the model.

**Step 1:** Start the Select command

- Choose Home tab→Select group→Select.
- Position the cursor over the face shown above. When it highlights, click to select it.

Notice that QuickBar (A) and a handle (B) are displayed, as shown below. This handle is called the steering wheel. It allows you to interact with the faces of the model.
Step 2: **Steering wheel overview**

When you select a face on a model, the default QuickBar action is to move the face. You can specify other options, but for this tutorial, you will focus on the Move option.

The steering wheel allows you to manipulate model elements, such as to move or rotate one face, or a set of faces.

You can use the different controls on the steering wheel to control the manipulation process.

The following explains some of the fundamental features of the steering wheel when using it to move faces along a linear vector:

- (A) Primary axis - Click this to move elements along this axis.
- (B) Secondary axis - Click this to move elements along this axis.
- (C) Reposition secondary axis knobs - Click one of the four knobs to reposition the secondary axis in the selected direction.
- (D) Origin knob - Used to define the from point for from/to moves. You can also click/drag the origin knob to reposition the steering wheel to another location on the model. This allows you to redefine the axis directions in which you want to move the face set based on another edge of the model, for example.

There are more features available with the steering wheel, but this provides you with the fundamentals.
Lesson 1  Basic part modeling

Step 3:  Modify the model using the primary axis on the steering wheel

☐ Position the cursor over the primary axis on the steering wheel, and when it highlights, click to select it, as shown above

☐ Move the cursor to the right and left.

Notice the following:

• The adjacent faces of the model update automatically as you move the face.

• The dimension value text of the PMI dimension updates.

• The dynamic input box is displayed near the cursor so you can type a precise value for the delta distance of the move.

☐ When the value of the PMI text displays approximately 100 mm, click to reposition the face.

Your display should be similar to the illustration below.
Step 4: Select another face to move

In the next few steps, you will reposition the hole feature using the secondary axis on the steering wheel. You will also rotate the secondary axis to define the move direction properly.

- Position the cursor over the circular face as shown above. When it highlights, click to select it.

The steering wheel and QuickBar are displayed similar to the illustration below.

Step 5: Reposition the secondary axis on the steering wheel

To move the hole feature in the proper direction, you must reposition the secondary axis on the steering wheel first.

- Position the cursor over the secondary axis knob (A) as shown above, then click to select it.

The secondary axis direction should update as shown below.
Lesson 1  Basic part modeling

Step 6:  Move the hole feature

- Position the cursor over the secondary axis on the steering wheel, and when it highlights, click to select it, as shown above.

- Move the cursor above the model vertically.

As before, the adjacent faces of the model update automatically, the PMI dimension text updates, and the dynamic input box is displayed near the cursor so you can type a precise value.

- When the dynamic input box displays approximately 20 mm, click to reposition the face. The dimension text should read approximately 90 mm.

Your display should be similar to the illustration below.
Modify the model by editing a dimension

In the next few steps, you will edit one of the PMI dimensions on the model.

**Step 1:** Select a dimension to edit

Position the cursor over the dimension text as shown above. When the dimension text highlights, click to select it.

The Dimension Value Input dialog box is displayed as shown below.
**Step 2: Dimension Value Input overview**

Take a few moments to observe the options on the Dimension Value Input dialog box and the display of the selected dimension.

- **(A) Edit Direction 1** - Specifies that the model geometry moves from this end when set. Notice that for this dimension, this option is cleared and the dimension has a dot at this end when the dimension is selected. If you change the dimension value, this end of the model remains stationary.

- **(B) Dimension Value box** - Specifies a precision value for the dimension. You can use this box to type new dimension values when editing models.

- **(C) Edit Direction 2** - Specifies that the model geometry moves from this end when set. Notice that for this dimension, this option is set and the dimension has an arrow at this end when the dimension is selected. If you change the dimension value, this end of the model can move.

- **(D) Locked/Unlocked** - Specifies whether the model geometry controlled by the dimension can change when making modifications with the steering wheel, or whether it must remained locked.

The reason you were able to modify the model geometry using the steering wheel in the previous steps was because the Locked/Unlocked option was set to unlocked for the two PMI dimensions you placed.
Step 3: Set the edit direction and type a new dimension value

On the Dimension Value Input dialog box, do the following:

- Ensure the Edit Direction 2 option is set. (A)
- Type 100 and press the Enter key. (B)

Step 4: Observe the results

Notice that the right end of the model changed in response to the dimension value edit.
Step 5: Save the part

On the Quick Access toolbar, click the Save button to save the completed part.

Congratulations!

You have completed this tutorial.

To learn more about Solid Edge: Synchronous Modeling Technology, you can do the following:

• Place additional PMI dimensions on the model geometry and edit the model to view the results.

• Use the steering wheel to edit different features of the model until you understand more of the options available.

• Select Solid Edge Help from the Help menu, and explore topics that are related to the subjects described in this tutorial.

• Select Tutorials from the Help menu, and explore the other tutorials available with Solid Edge.
Lesson

2  Intermediate Part Modeling and Editing

This tutorial demonstrates typical techniques for editing parts using Solid Edge with Synchronous Technology. It covers techniques such as:

- Defining temporary and permanent relationships between faces using the Relate command on QuickBar.

- Moving faces using the steering wheel.

- Live Rules

- Selection Manager

This tutorial does not demonstrate everything Solid Edge can do. Its purpose is to show you how powerful and intuitive Solid Edge: Synchronous Technology is, and to get you started so you can learn more on your own.
Lesson 2  Intermediate Part Modeling and Editing

Open a sample file

Step 1:  Open a Solid Edge file

☐ In the Solid Edge window, click the Application button, and then click Open.

☐ In the Open File dialog box, navigate to the Solid Edge Training folder.

If you installed Solid Edge in the default location, the training folder is located at:

C:\Program Files\Solid Edge ST\Training

☐ In the training folder, select stppbac.par.

Step 2:  Save a new version of the file

You or someone else may want to work through this tutorial again, so rather than editing the original version of the file, save the version you will edit for this tutorial to a new location.

☐ On the Application menu, choose Save As.

☐ On the Save As dialog box, save the part to a new name or location so that other users can complete this tutorial.
Define a relationship between faces

Step 1: Evaluate the part

Take a few moments to evaluate the part illustration, as shown above:

- Notice that the cylindrical faces (A) are not coaxially aligned (concentric).
- Notice that the planar faces (B) are not coplanar (coincident).

To demonstrate how you can edit the position of existing faces using the Relate command on QuickBar, in the next few steps, you will make the two cylindrical faces coaxial/concentric and the two planar faces coplanar/coincident.

Doing this will make the two mounting arms on the part symmetric with one another, as shown below.
Step 2: Start the Select command

The Select tool lets you select elements so they can be edited, copied, and deleted.

Choose Home tab→Select group→Select.
Step 3: Select the face you want to move

Position the cursor over the cylindrical face shown in the illustration, and when it highlights click to select it.

Notice that QuickBar (A) and the steering wheel (B) are displayed.
Step 4: QuickBar overview

QuickBar evaluates the selected elements and presents a targeted set of Actions and Options.

**Actions:**

The Actions list is displayed on the left side of QuickBar (A).

When a face is selected, the default QuickBar action is to move the face using the steering wheel. You can also select a different action from the Actions list.

**Options:**

The options available for the current action are displayed on the remainder of QuickBar (B).

For example, when moving a face, you can specify how the adjacent faces on the model react to the move, whether the original face is moved, or copied, and whether the face is detached from the model during the move operation.

For this operation, you want to move the face such that it is concentric with another face on the model. To do this, you will use the Relate command in the Actions list.
Step 5: Start the Relate command

On QuickBar, in the Actions list, choose the Relate command, as shown above.

You can use the Relate command to modify the position and orientation of one or more selected faces such that they are geometrically related to a target face on the part.

Step 6: Observe the Relate QuickBar

Take a few moments to observe the options on the Relate QuickBar:

- The Connected Faces option controls how adjacent faces are modified when you apply the relationship.
- The Single/All option controls whether only the first face you select or all the selected faces are modified when you apply the relationship.
- The Persist option controls whether a persistant relationship is created. When this option is set, a relationship is added to the Relationship collection in PathFinder. If you modify the faces later, the relationship is honored.
- The Relationships option lists the various relationship types you can apply. In this case, because you selected a cylindrical face, the inference technology built into Solid Edge determined the most likely relationship you want to apply is a Concentric relationship.

For this face, the Concentric option is the correct option.
Step 7: Select the target face

When you apply a relationship with the Relate command, you select a target face on the model. In this case, you want the face you selected earlier to be modified such that it is concentric with the cylindrical face shown highlighted above.

Position the cursor over the cylindrical face shown, then click to select it.

The face you selected earlier is moved such that it is concentric to the target face, as shown below.
**Step 8: Accept the target face**

At this point, you can either accept or cancel the change to the model.

☐ On the Relate QuickBar, choose Accept (check mark).

Notice that the cylindrical face is now concentric with the target face, and the steering wheel is displayed, as shown above.

☐ Click in empty space to clear the current selection.

**Step 9: Select the planar face to modify**

☐ Position the cursor over the planar face shown in the illustration, then click to select it.
Step 10: Start the Relate command

On QuickBar, in the Action list, choose the Relate command.

Step 11: Set the Persist and Coincident options on the Relate QuickBar

On the Relate QuickBar, set the Persist option.

On the Relate QuickBar, in the Relationships list, set the Coincident option, as shown below.

After you set these options, your QuickBar should match the top illustration.
Step 12: Select the target face

Position the cursor over the face shown, then click to select it.

The face you selected earlier is modified such that it is coplanar to (coincident with) the target face, as shown below.
Step 13: Accept the target face

- On the Relate QuickBar, choose Accept (check mark).

Notice that the planar face is now coplanar to the target face, and the steering wheel is displayed, as shown above.

- Click in empty space to clear the current selection.

The right arm is now symmetric with the left arm, as shown below.
Step 14: Display the coincident relationship in PathFinder

Because you set the Persist option for the coincident relationship, the relationship is available in the PathFinder tab.

☐ Click the symbol in PathFinder to expand the Relationships heading until your display matches the illustration.

Notice the following:

- A coincident relationship was added to the Relationships collection in Pathfinder.

The number adjacent to the coincident relationship on your computer may be different than the illustration.

**Note**

If the PathFinder tab is not displayed on your computer, choose View tab→Show group→Panes drop List→PathFinder.
Step 15: Select the coincident relationship in PathFinder

☐ In PathFinder, position the cursor over the coincident relationship, but do not click.

Notice that the model faces used to define the relationship highlight in the graphics window, as shown above.

☐ In PathFinder, click to select the coincident relationship, then move the cursor away.

Notice that the faces used to define the relationship are selected in the graphics window, as shown below.

You can use PathFinder to review, select, and delete relationships you apply between model faces. This can be useful when editing a model later.
Step 16: Save the part

- Click in empty space to deselect the relationship.

- On the Quick Access toolbar, located at the top-left side of the application window, click the Save button to save the work you have done so far.
Move faces using the steering wheel

In the next few steps you will modify the model to lengthen the mounting arms and relocate the cylindrical cutouts, as shown above.

While modifying the model, you will also continue to explore the tools that are available for modifying model geometry.
**Step 1:** Select the cylindrical cutout

Position the cursor over the cylindrical face shown in the illustration, then click to select it.

Several tools are displayed that you can use to evaluate and control how the model reacts to the modification:
- Steering wheel
- QuickBar
- Live Rules

In the next few steps, you will learn more about these tools.

**Step 2:** Observe the on screen tools

Notice the following, as shown in the top and bottom illustrations:
- A floating menu, called QuickBar is displayed in the graphics window (A).
• The steering wheel is displayed at the approximate point you selected the face (B).

• The Live Rules options window is displayed, as shown below.

![Live Rules Window]

- Suspend Live Rules
- Concentric
- Coplanar
- Tangent edges
- Tangent touching
- Parallel
- Perpendicular
- Symmetric about base
- Same radius if possible
- Orthogonal to base if possible
Step 3: Steering wheel overview

![Steering wheel diagram]

When you select a face on a model, the default QuickBar action is to move the face.

The steering wheel allows you to manipulate model elements, such as to move or rotate one face, or a set of faces.

You can use the different controls on the steering wheel to control the manipulation process.

The following explains some of the fundamental features of the steering wheel when using it to move faces along a linear vector:

- (A) Primary axis - Click this to move elements along this axis.
- (B) Secondary axis - Click this to move elements along this axis.
- (C) Secondary axis knobs - Click one of the four knobs to reposition the secondary axis in the selected direction.
- (D) Origin knob - Used to define the from point for from/to moves. You can also click/drag the origin knob to reposition the steering wheel to another location on the model. This allows you to redefine the axis directions in which you want to move the face set based on another edge of the model, for example.

There are more features available with the steering wheel, but this provides you with the fundamentals.
Step 4:  Live Rules overview

Depending on the current configuration of your computer, the settings for Live Rules on your computer may be different than the illustration.

On the Live Rules options window, click the Restore Defaults button.

Your Live Rules settings should now match the illustration.

You can use the Live Rules options to locate and display the inferred 3D geometric relationships between faces in the current select set and the rest of the model. You can then use this information to control how synchronous modifications are performed.

For example, when moving a planar face, you can use Live Rules to locate and display all the faces in the model that are coplanar to the face you are moving. You can then use Live Rules to specify whether any, some, or all of these coplanar faces are moved when the selected face moves.

Live Rules is available for the following types of synchronous modeling modifications:

• Moving or rotating model faces or features in a synchronous part or assembly document.

• Defining 3D geometric relationships between model faces using the Relate command in a synchronous part document.

• Editing the dimensional value of a 3D PMI dimension in a synchronous part or assembly document.

The current settings shown in Live Rules specify the following, as shown above:

• Concentric faces will remain concentric.

• Coplanar faces will remain coplanar.
• Tangent edges will remain tangent.

• Model symmetry about the base coordinate system will be maintained.

**Step 5: Move the cylindrical cutout**

☐ Position the cursor over the secondary axis on the steering wheel, and when it highlights as shown above, click to select it.

☐ Move the cursor slowly to the right, then to the left.

Notice the following:

• The concentric cylindrical face on the adjacent mounting arm also moves.

• The text for the Concentric and Symmetric About Base: (Y)Z options in Live Rules are displayed using a bold font.

  ![Concentric and Symmetric Options](image)

  `✓ Concentric (C)
  ✓ Symmetric about base (S)
  ✓ [Y] ✓ [Y] ✓ [Z] ✓ [Z]`

• When you move the cursor to the left, such that the cylindrical face extends past the end of the mounting arm, an error symbol is displayed.
Step 6: Synchronous technology in action

Options in Live Rules are displayed using a bold font when unselected geometry matches a Live Rules setting.

In this example, the Concentric and Symmetric about Base: (Y)Z settings in Live Rules ensured that the concentric cylindrical face which was not selected also moved when the selected cylindrical face moved.

- Concentric [C]
- Symmetric about base [S]
  - Y
  - YZ
  - Z

The error symbol was displayed because you moved the cursor such that the cylindrical cutout would no longer modify the part.

Synchronous technology ensures that you are notified for both of these conditions.

For this modification, you also want to lengthen the part, so additional faces are required in the select set.

In the next few steps, you will add the planar end face on the right mounting arm to the select set.
Step 7: Restart the move operation

□ Position the cursor in the graphics window, then right-click to restart the move operation.

Notice the following:

• The cylindrical faces are returned to their original positions.
• The steering wheel is redisplayed.
• The text for the Concentric and Symmetric about Base: (Y)Z options in Live Rules are no longer bold.
Lesson 2  Intermediate Part Modeling and Editing

Step 8: Add the planar end face to the select set

☐ Press and hold the Ctrl key on the keyboard down.

☐ Position the cursor over the planar face shown in the illustration, then click to select it.

Both the cylindrical face you selected earlier and the planar face should now be selected, as shown below.
Step 9: Move the faces using the steering wheel

- Position the cursor over the secondary axis on the steering wheel, and when it highlights as shown above, click to select it.

- Move the cursor slowly to the right, then to the left.

Notice the following, as shown below:

- The position of both cylindrical faces and the length of both mounting arms change as you move the cursor.

- The text for the Concentric, Coplanar, and Symmetric About Base: (Y)Z options in Live Rules are displayed using a bold font.

- The delta move distance is displayed near the cursor.
Step 10: Define the extent of the move operation

Position the cursor to the left such that the mounting arms are approximately 60 millimeters longer, as shown above, then type 60, and press the Enter key to precisely define the move distance.

The model should update as shown below.
Step 11: Save the part

- On the Quick Access toolbar, click the Save button to save the work you have done so far.
Move a cutout using the steering wheel

Step 1: Rotate the view

On the Viewing Commands toolbar, at the bottom-right side of the application window, choose Rotate.

In the graphics window, click the Z rotation axis, as shown above.

On the Rotate command bar, type -115, then press the Enter key.

The view is rotated as shown below.
Step 2:   Fit the view

On the Viewing Commands toolbar, choose Fit.
Step 3: Evaluate the next move operation

For the next move operation you will move the rectangular cutout down along the Z axis, as shown above.

You will explore additional options in Live Rules, and will also explore options for selecting faces using Selection Manager.
Step 4: Selection Manager Overview

In the next few steps, you will use Selection Manager to add more faces to the select set.

Selection Manager allows you to add elements to or remove elements from a select set based on the topological or attribute data of a currently selected focus element.

For example, Selection Manager is available when you select one or more model faces or features. Selection Manager contains menu items, similar to a shortcut menu.

Selection Manager signals that it is available by displaying a green symbol adjacent to the cursor, as shown above.

When you position the cursor over the green symbol, the symbol turns red, as shown below.
Step 5: Selection Manager Overview continued

When you left-click the red symbol, the Selection Manager menu is displayed, which allows you to add items to the current select set.

As you pass your cursor over the menu items in Selection Manager, faces on the model that match the menu criteria highlight in the graphics window.

For example, you can use Selection Manager to select all the faces which are part of a cutout feature to which the currently selected face belongs.

Step 6: Select a face

- On the Home tab, the Select command should be active.
- Position the cursor over the planar face at the approximate position shown in the illustration, then click to select it.

The steering wheel is displayed on the selected face.
Step 7: Use Selection Manager to select additional faces

- Position the cursor to the left of the steering wheel and over the face you selected, as shown above.

A green symbol should display adjacent to the cursor as shown above.

- Position the cursor over the green Selection Manager symbol, then click to display the Selection Manager menu.

Notice that the Selection Manager symbol changes color when the cursor touches it.

- Position the cursor over the title bar of the Selection Manager menu, then drag it to a location where you can see the entire face you selected, and as much of the model as possible

- Position the cursor over the Recognize→Cutout option, then click, as shown below.
Step 8: Observe the results

Notice that all the faces of the cutout are now selected.

Step 9: Select the primary axis on the steering wheel

Position the cursor over the primary axis on the steering wheel, then click to select it.

Move the cursor up and down vertically.

Notice the warning symbol displayed adjacent to the cursor, as shown below, indicating that the cutout feature cannot be moved along the primary axis.

In the next few steps you will learn why, and make adjustments to Live Rules so you can move the cutout feature.
Step 10: Observe Live Rules and the model

Take a few moments to observe Live Rules and the base coordinate system on the model. Notice the following:

- The cutout is symmetric about the base coordinate system in the (X)Y and (Y)Z principal planes, indicated by the bold font for the Live Rules options shown above.

- You are trying to move the cutout along the Z axis, which means the cutout would no longer be symmetric about the (X)Y plane.

The current settings for Live Rules prevent you from moving the cutout such that it would no longer be symmetric about the principal planes of the base coordinate system.

Step 11: Clear the Symmetric About Base (X)Y setting

On the Live Rules options window, clear the Symmetric About Base: (X)Y setting, as shown above.

Notice that you can now move the cutout feature up and down along the Z axis.
Step 12: Move the cutout feature

- Position the cursor below the part such that the delta move distance is approximately 18 millimeters, as shown above.
- In the dynamic input box, type 18, then press the Enter key.
- Move the cursor away from the part, then double-click the left mouse button quickly to clear the select set.

Your part should now display as shown below. Notice that when you cleared the select set, the steering wheel was also hidden.
Step 13: Rotate the view and save the part

- Press and hold the Ctrl key on the keyboard, then press the I key to rotate the view to the isometric orientation.

- On the Quick Access toolbar, click the Save button to save the work you have done so far.
Modify the model with advanced live rules

Step 1: Prepare to modify the model

In the next few steps you will modify the model to shorten the right mounting arm, as shown above.

While modifying the model, you will explore the Advanced page in Live Rules.
Step 2: Select the first face to move

- Position the cursor over the cylindrical face shown, and when it highlights, click to select it.

Step 3: Select the second face to move

- Hold the Ctrl key down, position the cursor over the face shown in the illustration, and when it highlights, click to select it.
Step 4: Select the secondary axis on the steering wheel

☐ Position the cursor over the secondary axis on the steering wheel, as shown above, and when it highlights click to select it.
Step 5: Observe Live Rules and the model

Move the cursor slowly to the left and right.

Take a few moments to observe the following:

- The position of both cylindrical cutouts and the length of both mounting arms change as you move the cursor.
- The text is displayed using a bold font for the Concentric, Coplanar, and Symmetric About Base: (Y)Z options in Live Rules.

As you learned earlier, options in Live Rules are displayed using a bold font when unselected geometry matches a Live Rules setting.

For this modification, you only want to change the position of the selected elements on the right mounting arm.

You could easily do that by clearing the Concentric, Coplanar, and Symmetric About Base: (Y)Z settings in Live Rules.

But for this modification, you will learn how you can use the Advanced page in Live Rules to display, review, and edit the list of elements that are included in a synchronous modification.
Step 6: Display the Advanced page in Live Rules

In Live Rules, click the symbol to display the Advanced page.

On the Advanced page, click the Edit button to display the list of faces.

The face list is displayed as shown in the top illustration.

You might find it easier to see the list of faces if you use the scroll bar in Live Rules to adjust the display of the Advanced page.
Step 7:  **Advanced page Overview**

The Advanced page on Live Rules displays the selected geometry and any related unselected geometry, in a tree-like structure, based on the current Live Rules settings.

You can use the options on the Advanced page to specify whether the listed relationships are maintained between the selected geometry and the related, unselected geometry. This allows you to adjust the result of the current synchronous modeling modification.

Notice the following:

- The selected faces are displayed using green text, which is boxed (A).
- The governing relationship is displayed indented underneath the selected faces (B).
- The related, unselected faces are displayed indented underneath the governing relationship, using grey-blue text. (C)
- For the cylindrical face you selected, the related unselected cylinder has two entries: one for the concentric condition, and one for the symmetric condition.
- For the planar face you selected, the related unselected plane has two entries: one for the coplanar condition, and one for the symmetric condition.
Step 8: Observe the Advanced page and the graphics window

Notice that the current move operation is suspended in the graphics window while the Advanced page is displayed.

Also notice that the face colors in the graphics window match the colors used on the Advanced page.

The selected faces are green (A), and the unselected, but related faces governed by Live Rules are grey-blue (B).

This helps you evaluate the impacts of the modification.
**Step 9:** Highlight faces using the Advanced page

You can also highlight faces in the graphics window using the Advanced page. This is helpful when working with large select sets.

- Position the cursor over the related cylindrical face listed on the Advanced page, as shown in the top illustration, but do not click.

Notice that the corresponding cylinder highlights in the graphics window.

- Use your cursor to highlight the other faces in the Advanced page, but do not click.
Step 10: Edit the Advanced page settings

- Position the cursor over the check box options adjacent to the Cylinder entries for Concentric and Symmetric as shown in the top illustration, then click to clear the check boxes.

- Position the cursor over the check box options adjacent to the Plane entries for Coplanar and Symmetric as shown in the bottom illustration, then click to clear the check boxes.
Step 11: **Observe the results**

Notice that the check boxes are now cleared on the Advanced page, as shown above.

Also notice that the corresponding faces are no longer displayed using the grey-blue color in the graphics window, as shown below.

This indicates that these faces are no longer governed by Live Rules.

Scroll the Live Rules window until you can see the Live Rules page, as shown below.

Notice that when you cleared the check box options for the two faces on the Advanced page, that the Maintain: Concentric, Coplanar, and Symmetric About Base (Y)Z rules were not changed. Clearing the face options on the Advanced page specified that you wanted to ignore Live Rules for these two faces only.

| ☑ Concentric (C) |
| ☑ Coplanar (P) |
| ☑ Symmetric about base (S) |
| ☑ XY | ☑ YZ | ☑ ZY |
Lesson 2  Intermediate Part Modeling and Editing

Step 12: Finish modifying the model

- On the Advanced page, click the Accept (check mark) button.

- In the graphics window, position the cursor to the right as shown above, and when the delta move value indicates the mounting arm is approximately 30 millimeters shorter, type 30 in the dynamic input box, then press the Enter key.

The right mounting arm is shortened by 30 millimeters, as shown below. Notice that the left mounting arm is not changed.
Step 13:  **Clear the select set and fit the view**

- Move the cursor away from the model geometry, then double-click the left mouse button quickly to clear the select set.

- On the Viewing Commands toolbar, choose Fit to fit the view.

Step 14:  **Save the part**

- On the Quick Access toolbar, click the Save button to save the completed part.
Congratulations!

You have completed this tutorial.

To learn more about Solid Edge: Synchronous Technology, you can do the following:

• Use the steering wheel and Live Rules to edit different features of the model until you understand more of the options available.

• Explore more options on Selection Manager.

• Select Solid Edge Help from the Help menu, and explore topics that are related to the subjects described in this tutorial.

• Select Tutorials from the Help menu, and explore the other tutorials available with Solid Edge.
Lesson

3  Building a Roller Assembly

This tutorial provides step-by-step instructions for building the assembly shown in the illustration above. As you build this assembly, you will learn techniques such as:

- Applying assembly relationships between parts.
- Using PathFinder to manage parts in the assembly.
- Applying fixed and floating offsets to relationships.
- Patterning parts in an assembly.
- Editing parts in the context of the assembly.

This tutorial does not demonstrate everything Solid Edge with Synchronous Technology can do. Its purpose is to show you how powerful and intuitive the Solid Edge: Assembly environment is, and to get you started so you can learn more on your own.
Lesson 3  

Building a Roller Assembly

Create a Solid Edge file

Step 1: Create a Synchronous ISO Assembly file

☐ Click the Application menu, point to New, and then click Synchronous ISO Assembly.

Step 2: Save the file

☐ On the Quick Access toolbar, located at the top-left side of the application window, click the Save button to save the file.

A properties dialog box is displayed. With this dialog box you could specify project and status information associated with the file. But since this is just an exercise, there is no point in doing that now.

☐ On the properties dialog box, click OK.

A Save As dialog box is displayed, where you can specify the name and location for the new file.

☐ Specify a name and location that are convenient for you and click OK.
Place a part in the assembly

**Step 1: Maximize the Parts Library pane**

You will be using both the PathFinder and Parts Library panes in this tutorial.

To make it easier to see the contents of the Parts Library and the PathFinder panes, you will maximize their size.

- On the bottom-left side of the Solid Edge window, click the Parts Library tab.  

- On the Parts Library tab, click the Maximize button, as shown above.
Lesson 3  
*Building a Roller Assembly*

**Step 2: Set the Parts Library folder**

If the working folder on the Parts Library tab is not the Solid Edge Training folder, do the following:

☐ On the Parts Library tab, click the arrow on the right side of the Look In control and then browse to the Solid Edge Training folder.

The default location of the Solid Edge Training folder is:

*C:/PROGRAM FILES\SOLID EDGE ST\TRAINING*

However, your system administrator may have chosen a different location.

Similar to Windows Explorer, you can define how you want to view the files listed in the Parts Library: Large Icons, Small Icons, List, and Details.

☐ On the Parts Library tab, click the Views button, and then set the Details option.
Step 3: Place the base plate part

To place a part into an assembly in Solid Edge, you select the part from the file list in Parts Library and then drag it into the assembly.

- In the file list area on the Parts Library tab, select the file named baseplate1.par, hold down the left mouse button, drag the file into the assembly window, and then release the mouse button, as shown above.

The baseplate is placed in the assembly, as shown below.

What is the relationship between this part and the rest of the assembly?

The first part you place in an assembly becomes the base component. Solid Edge places this part fixed, using a Ground relationship. No other relationships need to be applied to this part to fully position it in the assembly.
Step 4: Display PathFinder

In the next few steps, you will review the assembly using PathFinder, and then hide the base coordinate system shown in the graphics window.

- Click the PathFinder tab.

You can use the PathFinder tab to review and edit the assembly structure, hide and display assembly components, such as parts, subassemblies, coordinate systems, and reference planes.

Step 5: Highlight the base plate part

- In the top pane of PathFinder, position the cursor over the baseplate1.par entry, but do not click.

Notice that the base plate display changes color in the assembly window.

Move your cursor away and notice that the display returns to the previous color.
Step 6: Select the base plate part

In PathFinder, position your cursor over the base plate part again, then click, and move your cursor away.

Notice that the part color in the graphics window changes to a different color than in the previous step.

Also notice that when you select the part, the bottom pane of PathFinder displays the assembly relationships used to position the part, as shown below. Since this is the first part in the assembly, the relationship symbol that is displayed is the ground relationship.

When working in assemblies, you can temporarily highlight components using PathFinder, and you can also select them.
Lesson 3  Building a Roller Assembly

Step 7:  Display the coordinate systems collection

- In the graphics window, click in free space to deselect the base plate part.
- In PathFinder, position the cursor over the "+" symbol adjacent to the Coordinate Systems collection, as shown above, and click the left mouse button.

Notice that an entry for the Base coordinate system is displayed, as shown below.

There is one Base coordinate system in an assembly document, located at the exact center of the design space. Any additional coordinate systems you define are added to the Coordinate Systems collection in PathFinder.
Step 8: Hide the coordinate system

In PathFinder, position the cursor over the checkmark adjacent to the Base entry, then click to hide the coordinate system.

The coordinate system is hidden in the graphics window. Notice that the text in PathFinder for the Base entry has changed color.

You can use the checkboxes in PathFinder to display and hide assembly components.

The component entries in PathFinder also change color to indicate the current status of the assembly components.
Place another part in the assembly and relate it to the first part

In the next few steps, you will place and position the support part as shown.

Step 1: Part Positioning Overview

To position parts in an assembly, you apply a variety of assembly relationships.

For the support part, you will apply the following relationships to fully position the support part with respect to the base plate part:

• Mate
• Planar align
• Axial Align

Solid Edge provides a tool called FlashFit that allows you to apply each of these relationships, without having to specify the exact relationship type you want to use.

In the next few steps, you will use FlashFit to fully position the support as shown above.
Step 2: If You Have Trouble Placing Parts

After you have placed the first part in an assembly, you position the additional parts using assembly relationships.

☐ For the remainder of this tutorial, if you position a part incorrectly or lose your place while positioning a part, press the Esc key.

☐ Then use the Select tool command on the Home tab to select the part, and press the Delete key to delete the part.

You can then back up to the step where part placement begins, and try again.
Step 3: Place the support part

- Click the Parts Library tab.

- In the file list area on the Parts Library tab, select the file named support1.par, hold down the left mouse button, drag the file into the graphics window, and then release the mouse button at the approximate position shown in the top illustration.

The support part is placed into the assembly at the approximate position you release the mouse button, as shown in the bottom illustration.
Step 4: Examine the Assemble command bar

When you placed the second part into the assembly, the Assemble command bar was displayed.

Because you maximized the Parts Library tab earlier, you will need to maximize the Assemble command bar to see the options.

On the Assemble command bar title strip, click the Maximize button.

You should now see the Assemble command bar as shown in the top illustration.

Beginning at the top, examine the Assemble command bar, and notice the options:

The Options button displays the Options dialog box. You can use this dialog box to set the FlashFit options, Reduced Steps option, and so forth.

The Occurrence Properties button displays the Occurrence Properties dialog box. You can use this dialog box to define whether the part is displayed in higher level assemblies, counted in parts lists, and so forth.
Lesson 3  

Building a Roller Assembly

The Construction Display button allows you to display or hide elements for the part you are placing, such as reference planes, sketches, and construction surfaces. This can make it easier to position certain types of parts.

The Relationship List displays the relationships used to position a part. When editing the position of a part after placement, you can select the relationship you want to redefine from the list.

The Relationship Types option allows you to select which assembly relationship option you want to use for positioning a part.

The Floating and Fixed Offset buttons allow you to define whether the offset value is defined using another relationship you apply later (Floating Offset) or has a fixed numeric value based on the relationship you are currently defining (Fixed Offset).

The Offset Value box allows you to type the fixed offset value you want.
Step 5: Review the part placement options

- Use FlashFit as the default placement method
- Use Reduced Steps when placing parts
- Automatically Capture Fit when placing parts
- Use distance between faces as default offset
- Place as Adjustable
- Disperse after placement

FlashFit

Locate the following element types:
- Planar faces
- Cylindrical faces
- Circular edges
- Linear edges
- Points

Dimensions
- Show all dimensions

☐ On the Assemble command bar, click the Options button.

☐ On the Options dialog box, ensure that the options on your computer match the illustration.

Notice that the FlashFit option allows you to specify what types of faces you want FlashFit to recognize.

For this tutorial, and most part positioning scenarios, the FlashFit settings shown work well.
Step 6:  Mate the support to the base plate

When you select faces for the first assembly relationship, Solid Edge repositions the part you are placing based on the approximate positions on the faces you select on the placement part and the part in the assembly.

The first relationship you will use FlashFit to apply is a mate relationship.

A mate relationship positions a part by orienting two planar faces so that they face each other.

Mated faces can touch or be offset from each other. For this part, the default offset value of zero, where the parts touch, is the appropriate option.

☐ On the Assemble command bar, in the Relationship Types list, the FlashFit option should be active.
Step 7: **Use QuickPick to select the planar face on the support**

Depending on the current settings on your computer, a tooltip may be displayed adjacent to the cursor, as shown above. The Helpers page on the Solid Edge Options dialog box, available on the Application menu, allows you to specify whether a tooltip is displayed.

- Position the cursor over the face shown highlighted in the top illustration, stop moving the mouse for a moment, and notice that the cursor image changes to indicate that multiple selections are available. Also notice that the cursor image indicates which button you must click to display the QuickPick list. The default is to right-click to display QuickPick.

- Right-click, and the QuickPick list is displayed. Move the cursor over the different entries in QuickPick, and notice that different elements of the model highlight. QuickPick allows you to select exactly the element you want, the first time, without having to reject unwanted elements.

- Use QuickPick to highlight the planar face shown in the bottom illustration, and then left-click to select it.
Lesson 3  
*Building a Roller Assembly*

**Step 8: Select the mating face of the base plate part**

If the QuickPick cursor displays, but the proper face is highlighted, you can bypass QuickPick by left-clicking.

Select the top face on the base plate, as shown in the illustration.

**Step 9: Observe the result**

The mate relationship repositions the support part in the assembly. Because you have only applied one assembly relationship, the position of your support part might be slightly different than the illustration.
Step 10: Prepare to align the support and the base plate

In the next few steps, you will apply a planar align relationship to reposition the support part approximately as shown in the illustration.

A planar align relationship aligns two planar faces such that they both face the same direction.

For this part, you want to align the two faces on the support and base plate parts, as shown. These faces should not be coplanar—they will be parallel, but offset from one another.

Rather than specifying a specific offset distance, you will use a floating offset.

When you set the Floating Offset option, the offset value is determined by another relationship you apply later. In this case, you will apply an axial align relationship later to control the offset value after you apply the planar align relationship.
Step 11:  Select the aligning face on the support

- Position the cursor over the face shown in the top illustration, and wait for the QuickPick cursor to display.
- Right-click, then use QuickPick to select the planar face on the support shown in the bottom illustration.

Step 12:  Specify a floating offset

- On the Assemble command bar, click the Floating Offset button.

This setting allows the faces you are aligning to take on whatever offset value is appropriate to satisfy the axial align relationship you will apply later.
Step 13: Select the aligning face on the part in the assembly

Select the planar face on the base plate shown in the illustration. Remember that you can bypass QuickPick when the proper face is highlighted.
Step 14: Observe the result and flip the support

When positioning parts, FlashFit positioning logic analyzes the relative position of the faces you select to determine whether to apply a planar align or a mate relationship.

FlashFit applies the relationship that requires less part rotation. In this case, a mate relationship was the nearest solution.

For this part, a planar align relationship is required.

- On the Assemble command bar, click the Flip button to change the mate relationship to a planar align relationship.

The part is repositioned approximately as shown in the bottom illustration.
Step 15: Axially align the support part with the base plate

In the next few steps you will use FlashFit to apply an axial align relationship between a bolt hole on the support with a bolt hole on the base plate, as shown in the illustration.

The axial align relationship will fully position the support with respect to the base plate.

Step 16: Select the cylindrical face to align

☐ Use QuickPick to select the cylindrical face shown in the illustration.

You will align this cylindrical face with the cylindrical face on the base plate.
Lesson 3  Building a Roller Assembly

Step 17:  Select the cylindrical face on the base plate part

Select the cylindrical face on the base plate part as shown in the illustration.

Step 18:  Observe the result

The support part is now fully positioned in the assembly.

Notice that the Assemble command bar is dismissed, and the Select command bar is displayed instead.
Step 19:  Fit the window

Commands for adjusting the contents of the graphics window are located at the bottom-right side of the Solid Edge application window.

Choose Fit to fit the contents of the view to the graphics window.
Lesson 3  Building a Roller Assembly

Step 20:  Use PathFinder to review the assembly relationships

☐ Click the PathFinder tab.

☐ On the PathFinder title strip, click the Maximize button.

☐ In the top pane of PathFinder, click the support.par:1 entry, as shown above.

Notice that the relationships you applied display in the bottom pane of PathFinder, as shown below.

☐ Pass you cursor over each of the relationship listings, but do not click.

Notice in the assembly window, that the faces you used to apply the relationships highlight, as shown below.

Later, you will learn how to edit an assembly relationship.
Step 21: Save the assembly

On the Quick Access toolbar, choose Save to save the work you have done so far.

Place another instance of the second part

Step 1: Prepare to place another support part

In the next few steps, you will place another support part on the other side of the base plate, as shown in the illustration.

You will use the same steps you used to place the first support part.
Step 2: Place another support part in the assembly

- Maximize the Parts Library tab.

- Drag another support1.par part from the Parts Library tab and drop it into the assembly at the approximate location shown.

You will use FlashFit to first apply a mate relationship between the bottom face of the support and the top face of the base plate.
Step 3: Select the mating face on the support

☐ On the Assemble command bar title strip, click the Maximize button.

☐ Use QuickPick to select the bottom face on the support shown in the illustration.

Step 4: Select the mating face of the base plate part

☐ Select the top face on the base plate, as shown in the illustration.
Step 5: Observe the result

The faces you selected are mated.

Step 6: Select the face to align on the support part

- Use QuickPick to select the planar face on the support shown in the illustration.
Step 7: Specify a floating offset

Maximize the Assemble command bar, and then click the Floating Offset button.

Remember, this setting allows the faces you are aligning to take on whatever offset value is appropriate to satisfy the axial align relationship you will apply later.

Step 8: Select the aligning face on the part in the assembly

Use QuickPick to select the planar face on the base plate shown in the illustration.
Step 9: Observe the result and flip the support part

The second support part is positioned in the assembly approximately as shown in the top illustration.

Again, FlashFit applies the relationship that requires less part rotation, a mate relationship.

For this part, a planar align relationship is also required.

On the Assemble command bar, click the Flip button to change the mate relationship to a planar align relationship.

The part is repositioned approximately as shown in the bottom illustration.
Step 10:  Select the cylindrical face to align on the support part

☐ Use QuickPick to select the cylindrical face on the support shown in the illustration.

Step 11:  Select the cylindrical face to align on the base plate part

☐ Select the cylindrical face on the base plate shown in the illustration.
Step 12: Observe the result

The cylindrical faces on the support and base plate are axially aligned. The second support part is fully positioned within the assembly.

Step 13: Save the assembly

☐ On the Quick Access toolbar, choose Save.
Place another part in the assembly

Step 1: Prepare to place the roller part

In the next few steps, you will place and position the roller part shown in the illustration.

For this part you will use a mate relationship and an axial align relationship.

You will also use an option available with the axial align relationship to eliminate the need for a third relationship.

After the support part is fully positioned in the assembly, you will also edit the mate relationship to offset its position so it is positioned symmetrically between the two support parts.

Although you could position the roller part properly while applying the mate relationship, editing the relationship later makes it easier to see why it needs to be offset.
Step 2: Place the roller part in the assembly

- Ensure that the Parts Library tab is displayed and maximized.

- In the file list area on the Parts Library tab, select the file named `roller1.par`, hold down the left mouse button, drag the file into the assembly window, then release the mouse button at the approximate position shown in the illustration.
Step 3: Select the face to mate on the roller part

On the Assemble command bar title strip, click the Maximize button.

Select the planar face on the roller shown in the illustration.

Step 4: Select the mating face on the support part

Select the planar face on the support, as shown in the illustration.
Step 5: Observe the result

The mate relationship repositions the roller part in the assembly. Because you have only applied one assembly relationship, the position of the roller part might be slightly different than the illustration.

Step 6: Select the cylindrical face to align on the roller part

☐ Select the cylindrical face on the roller shown in the illustration.
Step 7: Set the Lock Rotation option

On the Assemble command bar, in the Placement group, set the Lock Rotation option.

Because this part is symmetric about a common axis, it makes no difference how the part is oriented about this axis in the assembly. In this situation, the Lock Rotation option is appropriate.

Step 8: Select the cylindrical face on the support part

Select the cylindrical face on the support shown in the illustration.
Lesson 3  Building a Roller Assembly

Step 9:  Observe the result

The roller part is now fully positioned in the assembly.

Step 10:  Save the assembly

On the Quick Access toolbar, choose Save.  

In the next few steps, you will reorient the view to look more closely at the result of the mate relationship.
Edit relationships in the assembly

Step 1: Rotate the view to a top orientation

Hold the Ctrl key on the keyboard down, then press the T key to rotate the view to the top orientation.

Step 2: Notice the clearance mismatch between the roller and support

Notice there is no gap between the roller and support parts on the right side, but there is a gap on the left side. When you applied the mate relationship, the default mate offset value was zero.

For this part, you want equal clearance on both sides of the roller. You will edit the offset value of the mate relationship to move the roller such that equal clearance is achieved.

There are commands available in Solid Edge on the Inspect tab that you can use to measure the gap distance between the parts. For this tutorial, you will be provided with the proper value for the offset.
Step 3: Select the roller in PathFinder

Ensure the PathFinder tab is displayed and maximized.

Position the cursor over the roller1.par entry in PathFinder, click to select it, then move the cursor away from the entry in PathFinder.

Notice the following:

- The relationships you used to position the part are displayed in the bottom pane of PathFinder, as shown below.

- The part color changes to the Select color in the graphics window.
**Step 4: Select the mate relationship**

In the bottom pane of PathFinder, click the entry for the Mate relationship.

Notice that the Mate command bar is displayed, and that in the graphics window the faces used to position the roller part highlight, as shown below.
Step 5: Edit the offset value for the mate relationship

If necessary, maximize the Mate command bar.

On the Mate command bar, in the Offset Value box, type 2, then press the Enter key.

In the graphics window, click in empty space to deselect the roller part.

In the graphics window, notice that the roller part is repositioned such that there is now equal clearance on both sides, as shown above.

Step 6: Rotate the view

On the keyboard, hold the Ctrl key down, then press the I key to rotate the view to the isometric orientation.
Step 7: Save the assembly

On the Quick Access toolbar, choose Save.

In the next few steps, you will place a bolt into one of the holes on the support part, then you will pattern the bolt.
Place bolts in the holes

Step 1: Place the first bolt

Ensure the Parts Library tab is displayed and maximized.

In the file list area on the Parts Library tab, select the bolt24x50.par file, hold the left mouse button down, drag the file into the graphics window, then release the mouse button at the approximate position shown.
Step 2: Use the Zoom Area command

On the Viewing commands toolbar, choose Zoom Area, then zoom in as shown in the illustration. This will make it easier to place the bolt.

After you have resized the view area, right-click to exit the Zoom Area command.
Step 3: Insert the bolt into the support

You will use a different part positioning option to position the bolt.

☐ Maximize the Assemble command bar.

☐ On the Assemble command bar, in the Relationship Types list, click the Insert option, as shown above.

The Insert option applies a mate relationship and an axial align relationship between the part being placed and a part in the assembly. The axial align relationship is placed using the Fixed option, which fixes the rotational orientation of the part.

If you need to control the rotational orientation of the part, you can edit the axial align relationship later. The Insert option is very useful for assembling a cylindrical part, such as a bolt, into a hole.

**Note**

The Insert option requires that all relationships are placed to only one part in the assembly. If the part you are placing needs to be positioned with respect to more than one part in the assembly, you must place the relationships individually using FlashFit, or the Mate and Axial Align options.
Step 4: Select the planar face to mate on the bolt

☐ Select the planar face shown in the illustration.

Step 5: Select the planar face on the support

☐ Select the planar face shown in the illustration.
Lesson 3  Building a Roller Assembly

**Step 6:**  Select the cylindrical face on the bolt

☐  Select the cylindrical face shown in the illustration.

**Step 7:**  Select the cylindrical face on the support

☐  Select the cylindrical face shown in the illustration.
Step 8: Observe the result

The bolt is inserted into the support.

Step 9: Fit the assembly window

☐ Choose Fit to fit the contents of the view to the graphics window.
Lesson 3  

Building a Roller Assembly

Step 10: Pattern the bolt

In the next few steps you will use the Pattern command to copy the bolt into the remaining holes on both support parts, as shown above. In this example, you will use a pattern feature on the base plate to pattern the bolts.

☐ Choose Home tab→Pattern group→Pattern.

The Pattern command allows you to copy a part in your assembly into a pattern. You define the pattern by selecting a pattern feature on a part in the assembly. The patterned parts are not positioned using assembly relationships, but are positioned using the pattern feature you select.

Step 11: Select the bolt

☐ Select the bolt.

☐ On the Pattern command bar, click the Accept button.
Step 12: Select the part containing the pattern

☐ Select the base plate part.

Step 13: Select the feature pattern on the base plate

☐ Select the pattern of holes on the base plate, as shown in the illustration.
Lesson 3  
*Building a Roller Assembly*

**Step 14:** Select a reference position on the pattern

![Diagram of a roller assembly with bolts placed](image)

- Select the hole on the base plate where you placed the first bolt.

**Step 15:** Finish the pattern

![Completed roller assembly](image)

- On the Pattern command bar, click the Finish button.

The bolts are positioned in the holes in both support parts, as shown.
**Step 16: Save the assembly**

On the Quick Access toolbar, choose Save.

In the next few steps, you will use the Select tool and the steering wheel to modify two parts within the context of the assembly.
Modify parts in the assembly

Step 1: Display the base coordinate system for the base plate

- Display the PathFinder tab.
- In the top pane of PathFinder, position the cursor over the baseplate1.par entry, then right-click to display the shortcut menu.
- On the shortcut menu, point to Show/Hide Component, then choose the Coordinate Systems option. This displays the base coordinate system for the baseplate1 part.
- In the graphics window, click in empty space to deselect the baseplate1 part.

The base coordinate system for the base plate part is displayed in the graphics window, as shown below.
Building a Roller Assembly

Step 2: Change the Selection Filters option and maximize the Select command bar

Choose Home tab→Selection Filters→Select Priority list→Faces option.

On the Select command bar, click the Maximize button.

The Faces option makes it possible to select faces before parts. This is a useful option when you are editing a model by moving faces with the steering wheel.

Step 3: Select the face on the base plate

Position the cursor over the face shown in the illustration, then click to select it.

Step 4: Observe the steering wheel, QuickBar, and Live Rules
Notice the new tools which are displayed when you selected the face:

- The steering wheel (A) is displayed at the location on which you selected the face.
- The Move QuickBar (B).
- The Live Rules pane, as shown below.

You will learn more about these tools in the next few steps.
Step 5: Steering wheel overview

You can use the steering wheel to move or rotate faces on one or more parts in the context of an assembly. The default QuickBar action is to move the face. You can specify other options, but for this tutorial, you will focus on the Move option.

You can use the different controls on the steering wheel to control the manipulation process.

The following explains some of the fundamental features of the steering wheel when using it to move faces along a linear vector:

- (A) Primary axis - Click this to move elements along this axis.
- (B) Secondary axis - Click this to move elements along this axis.
- (C) Reposition secondary axis knobs - Click one of the four knobs to reposition the secondary axis in the selected direction.
- (D) Origin knob - Used to define the from point for from/to moves. You can also click/drag the origin knob to reposition the steering wheel to another location on the model. This allows you to redefine the axis directions in which you want to move the face set.

There are more features available with the steering wheel, but this provides you with the fundamentals.
Step 6: Live Rules overview

Depending on the current configuration of your computer, the settings for Live Rules on your computer may be different than the illustration.

In Live Rules, click the Restore Defaults button.

Your Live Rules settings should now match the illustration.

You can use the options in Live Rules to control the solve behavior of the model during any of the following types of synchronous modeling modifications:

- Moving or rotating model faces or features in a synchronous part or assembly document.
- Defining 3D geometric relationships between model faces using the Relate command in a synchronous part document.
- Editing the dimensional value of a 3D PMI dimension in a synchronous part or assembly document.

The current settings shown in Live Rules specify the following:

- Concentric faces will remain concentric.
- Coplanar faces will remain coplanar.
- Tangent edges will remain tangent.
- Model symmetry about the base coordinate system will be maintained.

For the current move operation, the Symmetric About Base option will be illustrated.
Note

When editing parts using the steering wheel and Live Rules, symmetry about the base coordinate system is determined with respect to the base coordinate system in the part document in which you have selected the face.

Step 7: Modify the model using the primary axis on the steering wheel

Position the cursor over the primary axis on the steering wheel, and when it highlights, click to select it, as shown above.

Move the cursor to the left and right.

Notice the following as you move the cursor:

- The adjacent faces of the model update automatically as you move the face.

- Live Rules updates, with the Symmetric About Base: (Z)X option now displayed in bold text.

- The model is modified symmetrically about the (Z)X plane of the base coordinate system.

- The dynamic input box is displayed near the cursor so you can type a precise value for the delta distance of the move.

Position the cursor such that the model face is larger than its original size, then in the dynamic input box, type 40, then press the Enter key.
Step 8: Observe the result

Notice that the width of the base plate was increased in size by a total of 80 millimeters, divided symmetrically about the (Z)X plane of the base coordinate system of the base plate part.

**Note**

When editing parts using the steering wheel and Live Rules, symmetry about the base coordinate system is determined with respect to the base coordinate system in the part document in which you have selected the face.
**Step 9:** Prepare to select another face to move

Move the cursor away from the parts and the steering wheel, then double-click the left mouse button quickly to clear the select set and restart the Select command.

In the next few steps, you will reposition the hole feature on the right support part using the secondary axis on the steering wheel, as shown above. Because the support part was placed in the assembly twice, both supports will update.

This move operation will also illustrate how the Maintain: Concentric option in Live Rules ensures that faces which are concentric to the face or feature you are moving stay concentric.

The position of the roller part will update as well due to the assembly relationships you applied earlier.
Step 10: Select the hole feature on the support

- Position the cursor over the face shown in the top illustration, then wait for the QuickPick cursor to display.

- Right-click to display the QuickPick list, then position the cursor over the Hole 9 entry. Also notice that at the bottom of the QuickPick list, the occurrence name is displayed: support1.par:1, as shown below.

- In QuickPick, click to select the hole feature on support1.par:1.
Step 11: Reposition the secondary axis on the steering wheel

Notice that the steering wheel is now centered over the hole feature, as shown above.

Position the cursor over the secondary axis knob (A) as shown below, then click to select it.

Notice that the secondary axis is now pointed up vertically.
Lesson 3  Building a Roller Assembly

Step 12: Move the hole feature

☐ Position the cursor over the secondary axis on the steering wheel, and when it highlights, click to select it, as shown above.

☐ Move the cursor above the model vertically.

As before, the adjacent faces of the model update automatically, and the dynamic input box is displayed near the cursor so you can type a precise value.

☐ In the dynamic input box, type 80, then press the Enter key, as shown below.
Step 13: Observe the result

The height of the support part is lengthened as shown. Notice that the outer faces on the support parts stayed concentric to the hole feature you moved, due to the Live Rules - Maintain: Concentric option.

The position of the roller part also updates, due to the assembly relationships you applied.

Step 14: Save the final assembly

On the Quick Access toolbar, choose Save to save the completed part.
Congratulations!

You have completed this tutorial. To learn more about Solid Edge, you can do the following:

• Try editing the relationships you created in the assembly until you understand all of the options available.

• Use the Select tool, the steering wheel, and Live Rules to make more edits to the model faces in the assembly.

• Select Solid Edge Help from the Help menu, and explore topics that are related to the subjects described in this tutorial.

• Select Tutorials from the Help menu, and explore the other tutorials available with Solid Edge.